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Document template in Word for dissertations 
at Stockholm University 

Stockholm University Library offers a Word template to anyone who is writ-
ing a doctoral dissertation or other major work. The template is a regular Word 
document and consists of only a few pages, The Table of Contents and a first 
chapter heading. However, the template is customized so it has the right page 
size S5, the right margins, automatic page numbering and contains custom 
stylesheets such as the different heading levels from 1-9 and the body text 
Normal. 

Why use the template? 
The advantage of using the template is that you get an automatically updated 
table of contents, automatic page numbering and you do not have to think 
about the layout. Everything is customized and designed to look good in S5 
format. There is no requirement to use the template but it is a service. If you 
would rather do the layout yourself, you will do well. You can then make your 
own in S5 format or in A4. If you write in A4, make sure the pages look good 
in about 80% of A4. A4 pages are shrunk to S5 if you select S5 in the produc-
tion plant. 
If you have already started writing in A4 and want to copy and paste the text 
into the template, be sure to select "Merge formatting" instead of "Preserve 
source formatting" or any of the other options as you may get wrong format-
ting from the previous document. 
.  
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Production tool 
The word template starts with the Table of Contents, all previous pages like 
half title page1, title page, print site page and dedication page you create in the 
university's production tools. It is a simple and self-instructing tool where you 
also create the cover of the book. Link to the Production Tool: https://su.pow-
erinit.com/  

You log into the production tool with your SU account and this is also 
where you upload your completed pdf and, when you feel ready, first request 
approval of the dissertation support and then order your proofs from the print-
ing office. 

 
1 Half title page is the page in a book that precedes the main title page and contains only author 
name and book title 

https://su.powerinit.com/
https://su.powerinit.com/
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The word template 

A tip that makes using Word a little easier and clearer is to use the Navigation 
menu on the left in the picture below. It gives you a good overview of the 
entire document in different views such as Headings and Pages. There is also 
a good search function. Open the Navigation window by checking the box 
"Navigation window" under the "View" tab. 

 
Figure 1 Navigation window 
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Another tip is to use "Show/Hide" to see all hidden formatting characters in 
the document, e.g. page breaks, paragraph breaks, and paragraph characters. 
It does not have to be turned on all the time but can be good for troubleshoot-
ing if something looks strange in the document. 

 
Figure 2 Show/Hide 

Page size and font 
The template page size is S5, i.e. 24.2 cm x 16.5 cm and the font is Ti-mes 
New Roman in the body text and Arial in the Table of Contents. The font size 
is 11 points and the line spacing is at least 13 points. 

 
Figure 3 The template page size 
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The margins are 1.8 cm at the top, 2.2 cm at the bottom and 2.25 at the right 
and left edges. 

 
Figure 4 The template margins 

You will find this information under the tab "Layout - Print Size - Size - More 
Paper Sizes". 

The styles 
Styles are predefined formats for text such as font, size, line spacing, etc. If 
you use style sheets consistently, the text will be formatted uniformly and the 
header format will automatically update the table of contents. There are a 
number of custom styles to choose from for different sections of your text. 
Heading levels 1-9, body text format Normal and Normal with indentation and 
Image format eg.  
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For a complete list of styles, click on the Expand arrow under "Change Style": 

 
Figure 5 Styles 

To use a style sheet such as a chapter heading, place the cursor in the document 
where the heading is to be written and select the Heading level you want in 
the style sheet list. You can also type the heading first, select the text, and then 
click the heading in the stylesheet list. The text will automatically receive the 
correct formatting: the right font, the right size, the right amount of air above 
and below the text. The same goes for the other formats and the headings will 
appear in the table of contents. 

Headings 
In the document template, use the styles headings Headings 1–5 for headings 
in the regular body text. Heading level 1 used in the new chapter is preceded 
by a page break. You may not need to use all the title levels in your disserta-
tion. Many times you can do with three or four heading levels. Never put a 
point after the heading. For lists and enumerations, the heading “Rubrik vid 
lista”, which has italic style, is used if necessary. 

Automatic numbering of headings 
The headings are not numbered by default, but you can change to automatic 
numbering if you want. 
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Palce the marker on the first heading 1. In the Start menu: go to the "Para-
graph" block and click on "Multilevel list". In the list library: select 1. Heading 
1, 1.1 Heading 2, 1.1.1. Box 3… 

 
Figure 6 Automatic numbering of headings 
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Table of Contents 
The table of contents is included in the template from the beginning. It is up-
dated by selecting the table of contents, right-clicking and then selecting "Up-
date field". You can then select "Update page numbers only" or "Update en-
tire table" depending on whether only page numbers have changed or new 
headings have been added. 

 
Figure 7 Update Table of contents 

To make settings in the table of contents such as how many heading levels to 
include can be done by selecting the tab "References - Table of Contents - 
Custom Table of Contents". 
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Page numbering 
For the page numbers to be on the outer edge and not in the fold of the book, 
odd page numbers should be to the right and even to the left. In the template 
this is preset and the page numbering starts with page number 1 in the first 
chapter. 

Adjust page numbering 
The template is set so that the first chapter page gets page number 1. If you 
need to adjust the page numbering, e.g. to start with a later page number, do 
the following: Open the footer on the first chapter page by double-clicking the 
footer. Select "Page Number" in the menu and then "Format Page Number" 
to change the number format or page numbering in any way. 

 
Figure 8 Adjust page numbering 

Insert other numbering 
If you have inserted pages before the table of contents and want them to be 
numbered with Roman numerals, you first need to insert a paragraph break 
before the table of contents (it usually should not be numbered) and then go 
into the footer where you want page numbers and choose to insert page num-
bers. number, in the right place and formatting the page number. 
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You will find "Insert section breaks" under the "Layout" tab - "Breaks" - "Sec-
tion breaks". Usually you choose to start the paragraph break on "Next Page". 

 
Figure 9 Insert section breaks 

Body text 
Normal and Normal indentation is used for the running text. These are made 
for a running text and indented text. 

Normal is always used immediately after a heading and therefore has no 
first line indent. This format automatically follows Headings 1–5 when you 
press the Return key. 

Normal indentation is used for all subsequent paragraphs and therefore has 
a first-line indentation to mark the new paragraph. This format automatically 
follows Normal when you press the Return key. Note that paragraphs should 
not have a blank row in between. 
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Pictures and tables with description 
Images should be inserted using the "Insert - Pictures" feature. By using the 
Format “Bildformat”, the image is centered on the page and in addition an 
extra line of air is placed above the image (to separate it from the previous 
paragraph). In the image you can insert an image description with "Insert cap-
tion" from the "References" tab in the menu or by right-clicking on the image 
and selecting "Insert caption". 

 
Figure 10 Insert caption 

The pictures and tables will then automatically be numbered correctly and you 
can also create a Table of Contents of your pictures and tables in the same way 
as the Table of Contents of the chapters. You do this by "Insert figure chart". 
Insert figure / table list here under "References" - "Insert table of figures" 

 
Figure 11 Insert table of figures 
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Quotes 
When writing longer quotes (longer than about three rows), the quotation text 
is usually broken out of the body text by an indentation along the entire left 
and right edges and a blank space above and below the retracted paragraph. 
For this purpose, there are two different styles. 

Quotes are used for the first paragraph of the block quote and have air before 
and no indentation on the first line. Quotes with indentations are used for all 
subsequent paragraphs and have indentations on the first line but not air before. 
To get a blank space after the quote, press the return key. 

 
“When writing shorter quotes, quotation marks are used instead of block 
quotes. Then the same format is used as in the paragraph. " 

Footnote text and footnote reference 
Footnotes are automatically inserted under the tab "References" - "Insert foot-
notes".The footnotes text and Footnote reference styles are used to format text 
that for some reason has lost its formatting, e.g. when cutting and pasting text. 

 
Figure 12 Insert Footnote 
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Lists 
For enumeration, there are different styles: simple list (without dots or num-
bers), 
1. Numbered list 
I Roman list 
• Bullet list 
 
All are available with or without indentation on the left edge. The format tem-
plates for the lists do not have air either before or after. Therefore, create a 
blank line before the first enumeration and start the next paragraph with the 
format “Standard med luft”. 

Bibliography 
Literature lists are made using the format “littteraturlista med siffror” (litera-
ture list with numbers) and and “litteraturlista utan siffror” (literature list with-
out numbers). The literature list without numbers has so-called hanging in-
dents, ie. the first row of each piece starts out in the left edge and the subse-
quent rows are indented. The literature list of numbers is instead numbered 
with Arabic numerals. 

Both formats work just fine with different reference management programs 
such as Zotero or EndNote. Insert the references first and then select them and 
select one of the formats. Numbering that comes with the entries can be main-
tained to create a numbered reference list. Then use Literature list without 
numbers. 

To copy and paste text into the template 
You can of course copy and paste a finished text into the template. What is 
important to keep in mind when pasting the text is to right-click where the text 
is to be selected and select either "Merge formatting" or "Use target theme" 
(if that option is available) at least not select "Preserve source formatting" 
because then you get wrong formatting from your previous document. 
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Attachments 

Examples of styles in the template 
Heading 1 Chapter heading that always inserts a page 

break before the heading 
Heading 2-5 Headings in hierarchical order 
Rubrik vid lista Used for different types of lists 
Onumrerad rubrik Used for headings prior to Chapter 1, e.g. 

List of Papers. Headings that have this for-
mat will not be included in the table of con-
tents 

Normal Used for body text 
Normal indent Used in subsequent sections of a chapter 
Quote Used for long standalone quotes that are 

longer than 3 rows 
Quote indent Provides new paragraph in quotation for 

very long quotes 
Footnote text Formats on footnotes are normally set auto-

matically 
Footnote References The format of footnote references is nor-

mally set 
Abbreviations Used only for the abbreviation heading 
Innehållsförteckning Used only for the heading of the table of con-

tents 
Page number The format of the page number is normally 

set automatically 
Caption Used to describe images and tables, set auto-

matically 
Litteraturlistor med och utan  
siffror 

Formats bibliographies 

Listor/Lists Formats lists 
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